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. _____________________________________________________________________________________________________________________________________|
For safety, please read this manual carefully before you use this product and keep it handy for future reference.



Introduction
To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in this Manual

¢ NetWare 3.x means NetWare 3.12 and 3.2.
e NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple
Compuiter, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft®, Windows®, Windows Server®, and Windows Vista® are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corporation.
Novell, NetWare and NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

PCL is a registered trademark of Hewlett-Packard Company.

Solaris is a trademark or registered trademark of Sun Microsystems, Inc. in the United States and other
countries.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

* The product names of Windows 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

* The product names of Windows XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Media Center Edition
Microsoft® Windows® XP Tablet PC Edition

* The product names of Windows Vista are as follows:
Microsoft® Windows Vista® Ultimate
Microsoft® Windows Vista® Business
Microsoft® Windows Vista® Home Premium
Microsoft® Windows Vista® Home Basic
Microsoft® Windows Vista® Enterprise

e The product names of Windows Server 2003 are as follows:
Microsoft® Windows Server® 2003 Standard Edition
Microsoft® Windows Server® 2003 Enterprise Edition
Microsoft® Windows Server® 2003 Web Edition
Microsoft® Windows Server® 2003 Datacenter Edition
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Manuails for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.

To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

< Quick Installation Guide
Describes how to install the printer.

«+ Setup Guide
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

% Printer Reference
Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Operating Instructions”.

« Network Printing Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend
this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Operating Instructions” (this manual).

% PostScript 3 Operating Instructions Supplement

Describes the menus and features you can set using the PostScript 3 printer
driver. This manual is provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

& Note
O There are three CD-ROMs that come with this printer. "Operating Instruc-

tions", "Printer Drivers and Utilities", and "Document Management Utility".

O Concerning UNIX information, please visit our web site or consult your au-
thorized reseller.



How to Read This Manual

Symbols

In this manual, the following symbols are used:

/\ WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

/N\ CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

ﬂlmportant
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

5] Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

& Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

® Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

p Reference
This symbol indicates a reference.

[ 1]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.
]

Keys built into the machine's control panel.

Keys on the computer's keyboard.



This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Windows 2000
Windows XP/Vista
Windows Server 2003

E? - NetWare (Server)
| <&

e

T\

\I

NetWare @ /

(Client)

UNIX

ﬂlmportant

O The procedures written in this manual assume that you are a network administrator.
If you are not, be sure to consult your network administrator before configuration.

/O Reference

For more information about configuring the Network Interface Board with
the control panel, see the Setup Guide.

< Features

¢ Support for 100BASE-TX, 10BASE-T.

* The Network Interface Board is compatible with NetWare (IPX/SPX,
TCP/1P), Windows 2000 (TCP/IP, NetBEUI !, IPP *2), Windows XP/Vis-
ta, Windows Server 2003 (TCP/IP, IPP ?), UNIX (TCP/IP) and Macintosh
(AppleTalk) protocols. This allows you to use the machine in a network
that uses different protocols and operating systems.

* A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

To use NetBEUI, use the SmartDeviceMonitor for Client port.
IPP (Internet Printing Protocol) is a protocol for printing via the Internet.

*1
*2

% Interface supported protocols

Ethernet
Protocol TCP/IP O]
NetBEUI ©)
NetWare O
AppleTalk O

Omeans that the protocol is supported.



Setting Up the Machine on a Network

Windows 2000/XP/Vista, Windows Server 2003

For setting up the machine as a network printer in Windows 2000/ XP/Vista and
Windows Server 2003 environment.

See p.9 “Windows Configuration”.

« Printing Without a Print Server

TCP/IP TCP/IP TCP/IP TCP/IP

NetBEUI PP PP IPP

IPP LPR LPR LPR

Sy Ny Ny Ny
Windows 2000 Windows XP Windows Vista Windows Server 2003

« Printing With a Windows 2000 / XP / Vista or Windows Server 2003 Print Server

Windows 2000/XP/Vista
Windows Server 2003
Print Server

Windows 2000 Windows XP Windows Vista Windows Server 2003



NetWare

For setting up the machine as a network printer in a NetWare environment, see
p-23 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.

For more information about setting up the clients, see the following pages.
* See p.37 “Windows 2000/ XP/Vista, Windows Server 2003” .

Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

Print Server NetWare
= File Server

N N

Windows 2000 Windows XP Windows Vista Windows Server 2003

The actual procedures for configuring the machine depend on the NetWare version.

e NetWare 3.x
See p.25 “Setting Up as a Print Server”.

e NetWare4.x,5/5.1, 6
See p.31 “Setting Up as a Print Server”.



Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

NetWare NetWare
Print Server File Server
Ny
S

__/?/4‘

~> ~> ~> >
U 8 8 Q
Windows 2000 Windows XP Windows Vista Windows Server 2003

The actual procedures for configuring the machine depend on the NetWare ver-
sion.

¢ NetWare 3.x

See p.27 “Setting Up as a Remote Printer”.
e NetWare4.x,5/5.1, 6

See p.34 “Setting Up as a Remote Printer”.



Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p-39 “Macintosh Configuration”.

AppleTalk

S

Macintosh



UNIX

Concerning UNIX printing information, please visit our Web site or consult your
authorized reseller.

TCP/IP

&

UNIX



S
1. Windows Configuration

Preparing for Printing

Printing without a Print Server

The following procedure describes how to configure Windows to use the ma-
chine on a network without a Windows 2000 Server, Windows 2000 Profession-
al, Windows XP, Windows Vista, Windos Server 2003, or NetWare based print

server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e [PP
¢ NetBEUI (Only Windows 2000)

ﬂ Configure the chosen protocol.
¢ See p.11 “Configuring TCP/IP and IPP for Printing”.
¢ See p.13 “Configuring NetBEUI for Printing”.

B Install the software and set the printer driver port

¢ Install SmartDeviceMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows to enable Peer-to-Peer
printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows Help.

& Note

O If a device model selection dialog box appears during the procedure to add
the standard TCP/IP port, select "RICOH Network Printer C Model".

Printing with a LPR Port

See p.20 “Configuring LPR Port Printing” for configuring a LPR port.
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Windows Configuration

Printing with a Windows 2000/XP/Vista or Windows Server 2003
Print Server

See p.21 “Setting Up a Client Computer” for configuring Windows with a Win-
dows 2000/XP/Vista or Windows Server 2003 print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and the com-
puter to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.91 “Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [Programs], point to [Accessories], and then click [Com-
mand Prompt].
With Windows XP/Vista or Windows Server 2003, open the [Control Panel]]
from [Start].

® Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message
appears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message
appears.
Request timed out.

11
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Windows Configuration

Configuring a computer

Follow these steps to configure a computer to use the TCP/IP protocol.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

& Note
O With Windows XP or Windows Server 2003, open the [Control Panel] from
[Start], and then click [Network and Internet Connections].

O With Windows Vista, open the [Control Panel] from [Start], click [Network
and Internet], and then click [Network and Sharing Center], on the screen that
appears.

8 Click [Local Area Connection]. On the [General] tab, click [Properties].

@ Note

O With Windows Vista, click [View status], and then click [Properties] on the
screen that appears.

B Make sure that the”Internet Protocol (TCP/IP)” is selected in the [Compo-
nents checked are used by this connection:] box on the [General] tab.

& Note
O Select the TCP/IP protocol box if it is not already selected.

O If the TCP/IP protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.



Configuring the Protocols

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

5] Preparation
To use NetBEUI, use the SmartDeviceMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

ﬂ Click [Local Area Connection]. On the [General] tab, click [Properties].

BMake sure that the”NetBEUI Protocol” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

& Note
O Select the NetBEUI protocol box if it is not already selected.
O If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.

13
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Windows Configuration

Using SmartDeviceMonitor for Client

SmartDeviceMonitor for Client is a utility that helps you to use network printers
effectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartDeviceMonitor for Client to use
Parallel Printing and Recovery Printing. For more information about SmartDe-
viceMonitor for Client, see SmartDeviceMonitor for Client Help.

< SmartDeviceMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

¢ Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬁlmportant
O The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.



Using SmartDeviceMonitor for Client

Installing SmartDeviceMonitor for Client

Install SmartDeviceMonitor for Client from the CD-ROM labeled “Printer Driv-
ers and Utilities”. For more information about how to install, see the Setup
Guide.

After the installation is complete, configure the printer port with SmartDevice-
Monitor for Client. See p.17 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartDeviceMonitor for
Client, see SmartDeviceMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
DeviceMonitor for Client to print. On the [File] menu, click [Properties].

ﬂ Click the [Ports] tab, and then make sure that the SmartDeviceMonitor for
Client port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
EJ select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
(3 seiect the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartDeviceMonitor for Client port name as in step 2.

B click [pelete Port].

g When the confirmation message appears, click [Yes].
The port is deleted.

[[U Click [Close] to close the Printer Properties.

15
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Uninstalling SmartDeviceMonitor for Client

5] Preparation
Before uninstalling SmartDeviceMonitor for Client, make sure that:

* The port settings dialog box is closed.

e No printer is using the SmartDeviceMonitor for Client port as a printer
port.

* You have performed login with the same user authority as that used to in-
stall SmartDeviceMonitor for Client.-

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ Click the [Change or Remove Programs] tab, click [DeskTopBinder - SmartDevice-
Monitor for Client], and then click [Change/Remove].

B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartDeviceMonitor for
Client.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

B When the uninstallation is complete, click [OK].



Using SmartDeviceMonitor for Client

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
DeviceMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver for the printer you want to use.
ﬂ Access the [Printers] window from [Start] on the taskbar.

& Note
O With Windows XP or Windows Server 2003, open the [Printers and Faxes]]
window from [Start].

O With Windows Vista, open the [Control Panel] from [Start], click [Hardware
and Sound], and then click [Printers] on the screen that appears.

B Click the icon of the printer you want to use. On the [File] menu, click
[Properties].

O Click the [Ports] tab and click [Add Port].
B Click [SmartDeviceMonitor for Client] in the [Available port types:] box, and then

click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed.

The displayed items are as follows:

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.

B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

17
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NetBEUI (Only Windows 2000)

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Click the printer you want to use, and then click [OK].

4 Note

O Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For information about the printing of the
configuration page, see "Printing a Configuration Page" in the Setup
Guide. The NetBEUI address appears as "\ \RNPxxxx\xxx" on the con-
figuration page. Type the printer's network path name in the form of
"%%Computer name \Share name". Do not type "\\" as head characters
but "%%".

3 You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

@ Note

O For more information about these setting, see SmartDeviceMonitor for
Client Help.

U click [ok).
B Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].

This completes the settings.

To print, select the specified printer. SmartDeviceMonitor for Client will now
direct print data to the printer automatically.



Using SmartDeviceMonitor for Client

Changing Port Settings

Follow the steps to change SmartDeviceMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ Access the [Printers] window from [Start] on the taskbar.

& Note
O With Windows XP or Windows Server 2003, open the [Printers and Faxes]
window from [Start].

O With Windows Vista, open the [Control Panel] from [Start], click [Hardware
and Sound], and then click [Printers] on the screen that appears.

g Click the icon of the printer you want to use. On the [File] menu, click
[Properties].

B Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears

¢ For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-
ing and Timeout Settings.

¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.
& Note

O For more information about these settings, see SmartDeviceMonitor for
Client Help.

19



20

Windows Configuration

Configuring LPR Port Printing

& Note

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.11 “Configuring TCP /IP
and IPP for Printing”.

ﬂ Click [Start], point to [Settings], and then click [Printers].
The [Printers] window appears.

& Note
O With Windows XP Professional or Windows Server 2003, open the [Printers
and Faxes] window from [Start] on the taskbar.

O With Windows XP Home Edition, open [Control Panel] from [Start], click
[Printers and Other Hardware], and then click [Printers and Faxes] on the screen
that appears.

O With Windows Vista, open the [Control Panel] from [Start], click [Hardware
and Sound], and then click [Printers] on the screen that appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click
[Properties].

B Click the [Ports] tab and click [Add Port].
ﬂ In the [Available port types:] box, click “LPR Port”, and then click [New Port].

@ Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-

stalled. For more information about how to install "Print Services for Unix",
see Windows 2000 Help.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “lp” into the [Name of printer or print queue on that server box:], and then
click [OK].

U click [Close].

8 Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].



Setting Up a Client Computer

Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000/XP/Vista, Windows Server 2003 as a print server.

When using a Windows 2000/ XP/Vista or Windows Server 2003 print server,
select a shared printer on Windows 2000/XP/Vista or Windows Server 2003.
Windows 2000/XP/Vista,

Windows Server 2003
Print Server

Ni
Windows 2000/XP/Vista,
Windows Server 2003

? Limitation

O When using a print server connected to the printer with SmartDeviceMonitor
for Client, you cannot use Recovery Printing and Parallel Printing.

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000/XP/Vista or Windows Server 2003 print server.
Do not begin the following procedure until the client has been set up and con-
figured correctly.

Use the [Printers] window to set up the printer.
ﬂ Click [Start], point to [Settings] and then click [Printers].

B Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

E) clici Next >].
ﬂ Click [Network printer], and then click [Next >].
B click [Next>].

B In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.

2]
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ﬂ Click the printer you want to use, and then click [Next >].

@ Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and then follow the
instructions on the screen.

O There is a printer driver on the CD-ROM labeled “Printer Drivers and
Utilities”.

B Select whether to use this printer as the default printer, and then click [Next >].

g After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

NetWare must be set to active using the machine's control panel. For more infor-
mation about how to set it, see the Setup Guide.

2
**

DS

SmartDeviceMonitor for Admin
To use a printer in a NetWare environment, configure the NetWare printing
environment using SmartDeviceMonitor for Admin.

@ Note

O If you configure the NetWare printing using SmartDeviceMonitor for Ad-
min under the following environments, Novell NetWare Client is required:

* NDS or Bindary mode in Windows 2000/XP/Vista, Windows Server
2003

O Use the version of Novell Client provided with your operating system, or
the latest version.

Printers listed by SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin displays a list of printers connected to the
network.

If you cannot find the printer on the displayed list, refer to the configuration
page printed on the printer. For more information about printing a configu-
ration page, see Printer Reference provided as a PDF file on the CD-ROM la-
beled “Operating Instructions”

23
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x en-
vironment.

Basic Procedure

(Install SmartDeviceMonitor for Admin )

Print Server Remote Printer

( Configure Network Interface Board )

[ Configure NetWare )

Turn the power Start the print server

off and on

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Installing SmartDeviceMonitor for Admin

Install SmartDeviceMonitor for Admin on your computer. For the installation
procedure, see “Installing the SmartDeviceMonitor for Client/Admin” in the Setup
Guide.

After installing SmartDeviceMonitor for Admin, go to p.25 “Setting Up as a
Print Server” to use this computer as a print server, or to p.27 “Setting Up as a
Remote Printer” to use it as a remote printer.
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Setting Up as a Print Server

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
ﬂ Run SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPX/SPX].
A list of printers appears. g

& Note

O If you cannot identify which printer to configure from the list of printers,
print the configuration page and find it. For more information about print-
ing the configuration page, see “List/Test Print Menu” in the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating
Instructions”

O If no printer name appears on the list, match the IPX/SPX frame types be-
tween the computer and printer. Use the [Network] dialog box of Windows
to change the computer frame type. For more information about changing
equipment frame types, see “Configuring the Printer for the Network” in the
Setup Guide.

ﬂ Select the printer you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

B Click [Wizard], and then click [OK].

B Enter the device name in the [Device Name] box, a comment in the [Comment]
box if necessary, and then click [Next>].

ﬂ Select the [NetWare] check box, and then click [Next>].

8 Click [Bindery Mode], enter the file server name in the [File Server Name:] box,
and then click [Next>].

In the [File Server Name:] box, enter the name of the file server in which the
print server is to be created. You can also select a file server from the list that
appears by clicking [Browse].

g Enter the print server name in the [Print Server Name] box, the printer name
in the [Printer Name] box, and the print queue name in the [Print Queue Name]
box, then click [Next>].

¢ In the [Print Server Name] box, enter the name of the NetWare print server
using up to 47 characters.

¢ In the [Printer Name] box, enter the name of the NetWare printer.

¢ In the [Print Queue Name] box, enter the name of the print queue to be added
to NetWare.

25
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m After confirming the settings, click [Next>].
The settings take effect, and NIB Setup Tool closes.

m Exit SmartDeviceMonitor for Admin.

[E] Turn the printer power off and on.

& Note
E O To check the printer is configured correctly, enter the following after the
command prompt:

F:> USERLIST

O If the printer works as configured, the name of the print server appears as
an attached user.

26
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Setting Up as a Remote Printer

ﬂ Log on to the file server as a Supervisor or the equivalent of a Supervisor.
ﬂ Run the SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPX/SPX].
A list of printers appears.

& Note

O If you cannot identify which printer to configure from the list of printers,
print the configuration page and find it. For more information about print-
ing the configuration page, see “List/Test Print Menu” in the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating
Instructions”

O If no printer name appears on the list, match the IPX/SPX frame types be-
tween the computer and printer. Use the [Network] dialog box of Windows
to change the computer frame type. For more information about changing
equipment frame types, see “Configuring the Printer for the Network” in the
Setup Guide.

ﬂ Select the printer you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

ﬂ Click [Property Sheet], and then click [OK].

B Click the [NetWare] tab, and then make the following settings:
© In the [Print Server Name] box, enter the name of the print server.

@ In the [File Server Name] box, enter the name of the file server in which a
print server is to be created.

By clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

© In the [Print Server Operation Mode] group, click [As Remote Printer].
O In the [Remote Printer No.] box, enter the printer number.

iﬁklmportant
O Use the same printer number as that to be created in the printer server.

@ Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].

ﬂ On the [NIB] menu, click [Exit] to exit NIB Setup Tool.

8 Enter “PCONSOLE” after the command prompt.
F:> PCONSOLE

27
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g Create a print queue as follows:

& Note
O If you use a currently defined print queue, proceed to step 10.

@ On the [Available Options] menu, click [Print Queue Information], and then
press [ Enter].

@ Press [INSERT]), and then enter a print queue name.
® Press [ESC] to return to the [Available Options] menu.

[ﬁ] Create a printer as follows:

@ On the [Available Options] menu, click [Print Server Information], and then
press [ Enter]).

@ To create a new print server, press [INSERT], and then enter a print server
name.

If you are using a currently defined print server, select one of the print
servers shown in the [Print Server] list.

ﬂlmportant
O Use the same name as that specified in NIB Setup Tool. (Step 6 - 1).

© On the [Print Server Information] menu, click [Print Server Configuration].
@ On the [Print Server Configuration] menu, click [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.

ﬂ*lmportant
O Use the same number as that specified as the Remote Printer No. using

NIB Setup Tool. (Step 6 - 4).
O If you want to change the name of the printer, enter a new name.

“"_rm

The name “Printer x” is assigned to the printer. The “x” stands for the
number of the selected printer.
@ For type, click [Remote Parallel, LPT1].

IRQ, Buffer size, Starting form, and Queue service mode are automatically
configured.

@ Press the [ESC] key, and then click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to [Print Server Configuration Menu].
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ﬂ] Assign print queues to the created printer as follows:
@ From [Print Server Configuration Menu], click [Queues Serviced By Printer].
@ Select the printer created in step 10.
© Press the [INSERT] key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.
When you have finished the above steps, check the queues are assigned.

m Press the [ESC] key until “Exit?” appears, and then click [Yes] to close
PCONSOLE.

[B Start the print server by entering the following from the console of the Net-
Ware Server:

If it is running, restart it after exiting it.
< To exit

CAREE: unload pserver
< To start

CAREE: load pserver print_ server name

& Note
O If the printer works as configured, “Waiting for job” appears.

29
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NetWare 4.x, 5/5.1, 6 - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5/5.1, 6 envi-
ronment.

% To use NetWare 5/5.1, 6

¢ Use the printer as a print server.
Do not use as a remote printer.

¢ If you use Pure IP, configure the machine to use the TCP/IP protocol. For
more information about how to make the settings, see “Configuring the
Printer for the Network” in the Setup Guide.

Basic Procedure

(Install SmartDeviceMonitor for Admin )

Print Server Remote Printer

( Configure Network Interface Board )

( Configure NetWare )

Turn the power Start the print server

off and on

Installing SmartDeviceMonitor for Admin

Install SmartDeviceMonitor for Admin on your computer. For the installation
procedure, see “Installing the SmartDeviceMonitor for Client/Admin” in the Setup
Guide.

After installing SmartDeviceMonitor for Admin, go to p.31 “Setting Up as a
Print Server” to use this computer as a print server, or to p.34 “Setting Up as a
Remote Printer” to use it as a remote printer.
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Setting Up as a Print Server

ﬂlmportant
O You must set up the print server using NDS mode in NetWare 4.x, 5/5.1, 6.

ﬂ Log on to the file server as a Supervisor or the equivalent of a Supervisor.
ﬂ Run SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPX/SPX] or
[TCP/IP].

A list of printers appears.

& Note
O If you use Pure IP, click [TCP/IP].

O If you cannot identify which printer to configure from the list of printers,
print the configuration page and find it. For more information about print-
ing the configuration page, see “List/Test Print Menu” in the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating
Instructions” .

O If no printer name appears in the list, match the IPX/SPX frame types be-
tween the computer and printer. Use the [Network] dialog box of Windows
to change the computer frame type. For more information about changing
equipment frame types, see “Configuring the Printer for the Network” in the
Setup Guide.

ﬂ Select the printer you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

@ Note

O If you use Pure IP, see p.32 “Using Pure IP in the NetWare 5/5.1, 6 envi-
ronment”.

B Click [Wizard], and then click [OK].

E Enter the device name in the [Device Name] box, a comment in the [Comment]
box if necessary, and then click [Next>].

ﬂ Select the [NetWare] check box, and then click [Next>].

8 Click [NDS Mode], enter the file server name in the [File Server Name:] box, the
NDS tree name in the [NDS Tree:] box and the context in the [NDS Context:]
box, and then click [Next>].

In the [File Server Name:] box, enter the name of the file server in which the
print server is to be created. You can also select a file server from the list that
appears by clicking [Browse].

By clicking [Browse], you can select a NDS context from those listed in the
[Browse] dialog box.

For context, object names are entered from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS, en-
ter “NET.DS”.
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g Enter the print server name in the [Print Server Name] box, the printer name
in the [Printer Name] box, the print queue name in the [Print Queue Name] box,
and the print queue volume in the [Print Queue Volume], and then click
[Next>].

* In the [Print Server Name] box, enter the name of the NetWare print server
using up to 47 characters.

¢ In the [Printer Name] box, enter the name of the NetWare printer.

¢ In the [Print Queue Name] box, enter the name of the print queue to be added
to NetWare.

* In [Print Queue Volume], enter the print queue volume. As a volume, object
names are entered from a lower object and divided by a period. You can
select a volume by clicking [Browse].

m After confirming the settings, click [Next>].

NIB Setup Tool completion screen appears.

0 click [Finish].
The new settings are applied, and NIB Setup Tool closes.

[B Exit SmartDeviceMonitor for Admin.

[B Turn the printer power off and on.

4 Note

O To check the printer is configured correctly, enter the following after the
command prompt:

F:> NLIST USER /A/B

O If the printer works as configured, the name of the print server appears as
an attached user.

Using Pure IP in the NetWare 5/5.1, 6 environment

@ Note

O When not using IPX, it is recommended that you change the print server pro-
tocol in the Web browser from [TCP/IP+IPX] to [TCP/IP].

ﬂ Log on to the file server as an Admin or the equivalent of an Admin.
g Run SmartDeviceMonitor for Admin.

8 Click [Property Sheet], and then click [OK].
The [NIB Setup Tool] dialog box appears.
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ﬂ Click the [NetWare] tab, and make the following settings:
@ Select [File Server Mode] or [NDS Mode] as the Logon Mode.
@ In the [Print Server Name:] box, enter the name of the print server.

? Limitation
O Enter a maximum of 47 single-byte characters and numerals.

© In the [File Server Name:] box, enter the name of the file server in which a
print server is to be created.

By clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

O 1In the [NDS Tree Name:] box, enter the name of the NDS tree.

Click [Browse] to display the NDS Tree list in the [Browse Context] dialog
box. If you double-click the NDS Tree selected from the list, its NDS Con-
text is displayed. Click the selected NDS Context to display it reversed,
then click [OK] and the name of the selected NDS Tree and NDS Context is
added to the [NDS Tree Name:] and [NDS Context Name:] dialog boxes.

? Limitation
O Enter a maximum of 32 characters, including hyphens and underscores.
@ In the [NDS Context:] box, enter the context of the print server.

& Note
O When selecting from the list in step 4, the NDS Context is already added.

For context, object names are entered from a lower object and divided by a
period. For example, if you want to create a print server into Net under DS,
enter “NET.DS”:

O In the [Print Server Operation Mode] group, click [As Print Server].
@ Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].

B Exit SmartDeviceMonitor for Admin.
After this step, proceed to step 8 on p.31 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

ﬂ Log on to the file server as an Admin or the equivalent of an Admin.
ﬂ Run the SmartDeviceMonitor for Admin.
B On the [Group] menu, point to [Search Device], and then click [IPX/SPX].

A list of printers appears.

& Note

O If you cannot identify which printer to configure from the list of printers,

print the configuration page and find it. For more information about print-
ing the configuration page, see “List/Test Print Menu” in the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating
Instructions” .

If no printer name appears on the list, match the IPX/SPX frame types be-
tween the computer and printer. Use the [Network] dialog box of Windows
to change the computer frame type. For more information about changing
equipment frame types, see “Configuring the Printer for the Network” in the
Setup Guide.

ﬂ Select the printer you want to configure, and then click [NIB Setup Tool] on

the [Tools] menu.
B click [Property Sheet], and then click [OK].

E Click the [NetWare] tab, and make the following settings:
@ Select [File Server Mode] or [NDS Mode] as the Logon Mode.
@ In the [Print Server Name:] box, enter the name of the print server.

? Limitation
O Enter a maximum of 47 single-byte characters and numerals.

@ In the [File Server Name:] box, enter the name of the file server in which a

print server is to be created.

By clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

O 1In the [NDS Tree Name:] box, enter the name of the NDS tree.

Click [Browse] to display the NDS Tree list in the [Browse Context] dialog
box. If you double-click the NDS Tree selected from the list, its NDS Con-
text is displayed. Click the selected NDS Context to display it reversed,
then click [OK] and the name of the selected NDS Tree and NDS Context is
added to the [NDS Tree Name:] and [NDS Context Name:] dialog boxes.

? Limitation
O Input using a maximum of 32 characters including hyphens and under-
scores.
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@ In the [NDS Context:] box, enter the context of the print server.

& Note
O When selecting from the list in step 4, the NDS Context is already added.

For context, object names are entered from a lower object and divided by a
period. For example, if you want to create a print server into Net under DS,
enter “NET.DS”:

O In the [Print Server Operation Mode] group, click [As Remote Printer].
@ In the [Remote Printer No.] box, enter the number of the printer.

ﬂlmportant

O Use the same number as that of the printer to be created in the print
server.

@ Click [OK] to close the property sheet.
ﬂ On the [NIB] menu, click [Exit] to exit NIB Setup Tool.
8 From Windows, run NWadmin.

/O Reference

For more information about NWadmin, see the documentation provided
with NetWare.

g Create a print queue as follows:

@ Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

@ In the [Class of new object] box, click [Print Queue], and then click [OK].
© In the [Print Queue name] box, enter the name of the print queue.
O 1n the [Print Queue Volume] box, click [Browse].

@ In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

O After confirming the settings, click [Create].

[[U Create a printer as follows:

@ Select the container object the printer is located in, and then click [Create]
on the [Object] menu.

@ In the [Class of new object] box, click [Printer], and then click [OK]. When
you are using NetWare 5/5.1, 6, click [Printer (Non NPDS)].

© In the [Printer name] box, enter the name of the printer.
O Select the [Define additional properties] check box, and then click [Create].
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ﬂ] Assign print queues to the created printer as follows:
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step 9, and then
click [OK].

@ Click [Configuration], and in the [Printer type] list, click [Parallel], and then
click [Communication].

O Click [Manual load] in the [Communication type] group, and then click [OK].
@ After confirming the settings, click [OK].

m Create a print server as follows:

@ Select the context specified using NIB Setup Tool (Step 9 - 1), and on the
[Object] menu, click [Create].

@ In the [Class of new object] box, click [Print Server], and then click [OK].
When you are using NetWare 5/5.1, 6, click [Print Server (Non NPDS)].

© In the [Print Server name] box, enter the name of the print server.

ﬁlmportant
O Use the same name as that specified using NIB Setup Tool. (Step 6 - 2).

O Select the [Define additional properties] check box, and then click [Create].

[B Assign the printer to the created print server as follows:
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step 11, and then
click [OK].

© In the [Printers] group, click the printer assigned in step 13 - 2, and then
click [Printer Number].

O Enter the printer number, and then click [OK].

ﬂ*lmportant
O Use the same number as that specified as Remote Printer No. using NIB

Setup Tool. (Step 6 - 7).
@ After confirming the settings, click [OK].

ﬂ] Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after closing.

< To exit
CAREE: unload pserver

< To start
CAREE: load pserver print server name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

& Note

O Use the version of Novell Client provided with your operating system or the
latest version.

O This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If not,
install the necessary applications before starting the setting up procedure.

Windows 2000/XP/Vista, Windows Server 2003

Follow the procedure to set up a Windows 2000/ XP/Vista, Windows Server
2003 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Close all the applications that are currently running.

g Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide.

B The [Printer Installation] dialog box appears.

ﬂ From the [Port] list, select the queue you selected in step 1, and then click
[Next >].

B Follow the instructions on the screen to complete the installation of the
printer driver.
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NDPS
The machine operates using NDPS. Operating requirements are as follows:
e NetWare Version: 5.0, 5.1, 6

+ Printer Drivers and Operating Systems

Printer Driver oS

PCL Windows 2000
Windows XP
Windows Vista
Windows Server 2003

To use the machine with NDPS, NDPS Gateway is required.

* Novell NDPS Gateway
For more information about using Novell NDPS Gateway, see the manual
provided with it.

¢ Custom NDPS Gateway
For more information about using Custom NDPS Gateway, consult your au-
thorized retailer.

LFiPrint

This machine does not support iPrint.
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Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of the Mac OS. The following procedure describes how to configure Mac OS
9.1. If you are not using Mac OS 9.1, see the manual that comes with your version
of Mac OS for more information.

Basic Procedure

Change to EtherTalk )

(
(Configure the printer )
( Change the printer name)

Change the zone

? Limitation

O The required version of Mac OSis 8.6 or later. (Mac OS X Classic environment
is supported.)

Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

/O Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

Mac OS

ﬂ Open [Control Panel], and then double-click the [AppleTalk] icon.

B On the [Connect via:] pop-up menu, select “Ethernet”.

B If you change zones, select a name on the [Current zone:] pop-up menu.
O Close the [AppleTalk] dialog box.

B Restart the computer. 30
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Mac OS X

5] Preparation

You need an administrator name and a password (phrase). For more informa-
tion, consult your administrator.

ﬂ Open [System Preference], and then click the [Network] icon.
B Click the [AppleTalk] tab.
B If you change zone, select a name on the [AppleTalk Zone:] pop-up menu.

ﬂ When the setting is complete, click [Apple Now].

Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

A Reference
For more information about configuration, see the Setup Guide.

Changing the Printer Name

If the network has several similar model printers, the names will be the same.
Printers that have the same name will have their names slightly changed in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printerl” and “printer2”.

To change the printer name in the Macintosh EtherTalk environment, use the
Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers and
Utilities”.

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
the Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers
and Utilities”.

p Reference

For more information about using Printer Utility for Mac, see PostScript 3
Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers.
Also, you can change the configuration of the network interface board using
TCP/IP or IPX/SPX.

ﬂlmportant
O IPv6 cannot be used on this function.

« Protocol stack provided with Operating System

e Windows 2000
TCP/IP
IPX/SPX
NetWare
Novell Client for Windows NT /2000/XP

¢ Windows Server 2003
TCP/IP
IPX/SPX

e Windows XP
TCP/IP
IPX/SPX
Novell Client for Windows NT /2000/XP

e Windows Vista
TCP/IP
NetWare Client32 for Windows NT

« Available operations
The following functions are available:

¢ Printer Information function
¢ Display the network settings and detailed information of the printer.
* Display the number of pages printed under each user code.
* Display the status of print jobs sent from computers.
¢ Change the printer network settings.
¢ Device Settings function

* Lock some of the setting items on the control panel so that they cannot
be changed using the control panel.

¢ Select type of paper loaded in the paper trays.
* Energy Saver function

¢ Enable or disable the Energy Saver mode.
¢ System Status function

* Display the information such as when paper is depleted during printing
on a computer. A
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¢ Groups function

* Monitor multiple printers at the same time. When there are multiple
printers to manage, you can create groups and classify the printers to fa-
cilitate management.

* You can customize printer status according to groups, and send status
notification e-mail to a computer.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.
ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
ﬂ Click [SmartDeviceMonitor for Admin] installation, and then click [Next >].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading through its contents, click [l accept the agreement.] if you agree,
and then click [Next >].

B Follow the instructions on the screen.
A message appears when the installation is complete.

U crick [ok).

@ Note

O Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

O If you are required to restart the computer after installing SmartDevice-
Monitor for Admin, restart the computer and continue the configuration.
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Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configura-
tion using SmartDeviceMonitor for Admin.

ﬂ Start SmartDeviceMonitor for Admin.

g On the [Group] menu, point to [Search Device], and then click [IPv4] or
[IPX/SPX].

A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.

8 In the list, select a printer whose configuration you want to change.

ﬂ On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the user name and
password for the Web Image Monitor administrator appears.

@ Note

O To use the factory default account, enter no user name and enter “pass-
word” for the password.

B Configure settings using Web Image Monitor.
E Quit Web Image Monitor.
ﬂ Quit SmartDeviceMonitor for Admin.

/O Reference

For details about Web Image Monitor, see p.49 “Configuring the Network
Interface Board with a Web Browser”.
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Locking the Menus on the Printer's Control Panel

Follow the procedure below to lock the menus on the printer's control panel.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group] menu, point to [Search Device], and then click [IPv4] or [IPX/SPX].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.

B In the list, select a printer whose configuration you want to change.

ﬂ On the [Tools] menu, point to [Device Settings], and then click [System].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

@ Note

O To use the factory default account, enter no user name and enter “pass-
word” for the password.

The [System] page of Web Image Monitor appears.
B On the [Protect Printer Display Panel], select [Level 1] or [Level 2].
(3 ciick [ok).
ﬂ Quit Web Image Monitor.
B Quit SmartDeviceMonitor for Admin.

p Reference

For details about Web Image Monitor, see p.49 “Configuring the Network
Interface Board with a Web Browser”.
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Changing the Paper Type

Follow the procedure below to change the paper type.
ﬂ Start SmartDeviceMonitor for Admin.

g On the [Group] menu, point to [Search Device], and then click [IPv4] or [IPX/SPX].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.

B In the list, select a printer whose configuration you want to change.

ﬂ On the [Tools] menu, point to [Device Settings], and then click [Paper].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

@ Note

O To use the factory default account, enter no user name and enter “pass-
word” for the password.

The [Paper] page appears.
Select a paper type in the [Paper Type] list for each tray.

B Enter required setting items, click [OK].
B Quit Web Image Monitor.
ﬂ Quit SmartDeviceMonitor for Admin.

@ Note

O For details about Web Image Monitor, see p.49 “Configuring the Network
Interface Board with a Web Browser”.

O For details about setting items, see Help in the [Device Settings] on [Configu-
ration] page.
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Managing User Information

Follow the procedure below to manage the user's information using SmartDe-
viceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group] menu, point to [Search Device], and then click [IPv4] or [IPX/SPX].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.

B In the list, select a printer you want to manage.

ﬂ On the [Tools] menu, click [User Management Tool].
The dialog box for entering the user name and password appears.

@ Note

O To use the factory default account, enter no user name and enter “pass-
word” for the password.

B Enter the user name and password, and then click [OK].
User Management Tool starts.
& Note

O For details about User Management Tool, see SmartDeviceMonitor for Ad-
min Help.
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Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Group] menu, point to [Search Device], and then click [IPv4] or [IPX/SPX].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.

B Select the printer whose settings you want to make.
To make settings for all printers in the selected group, select no printer.
ﬂ On the [Group] menu, point to [Energy Save Mode], [Set Individually], and then
click [On].
To select all the printers in the group, select [Set By Group].
To disable Energy Save mode, click [Off].

ﬂ Quit SmartDeviceMonitor for Admin.

& Note

O For details about the setting value for Energy Saver mode, see SmartDe-
viceMonitor for Admin Help.

Checking the Printer Status

Follow the procedure below to check printer status.
ﬂ Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4] or [IPX/SPX].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.

8 To obtain status details, click the printer in the list, and then click [Open] on
the [Device] menu.

The printer status appears in the dialog box.

ﬂ Click [System] or [Printer].
The printer status appears in the dialog box.

B Quit SmartDeviceMonitor for Admin.

& Note
O For details about status icons and items in the dialog box, see SmartDevice-
Monitor for Admin Help.
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Viewing and Deleting Spool Print Jobs

ﬂ Start SmartDeviceMonitor for Admin.

g On the [Group] menu, point to [Search Device], and then click [IPv4] or [IPX/SPX].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.

& Note

O To use the factory default account, enter no user name and enter “pass-
word” for the password.

B Select a printer in the list, and then click [Spool Printing Job List(Printer)] on the
[Tools] menu.
A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

4 Note

O To use the factory default account, enter no user name and enter “pass-
word” for the password.

[Spool Printing Job List] appears in the Web Image Monitor.
ﬂ Quit Web Image Monitor.
B Quit SmartDeviceMonitor for Admin.

@ Note

O To display Spool Printing Job List, [Spool Printing] must be set to [Active] on
Web Image Monitor in advance.

O To delete the Spool Printing Job, select the document you want to delete
and then click [Delete].

O For details, see Help in the [Spool Printing Job List] area.

O For details about Web Image Monitor, see p.49 “Configuring the Network
Interface Board with a Web Browser”.
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Configuring the Network Interface Board
with a Web Browser

You can check the status of a machine and change its settings using the Web
browser.

% Configuring the machine
This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

p Reference

For more information about configuring the machine to use the TCP/IP
protocol, see the Setup Guide.

% Operating system browser requirements

Operating system Browser
Windows 2000/XP/Vista Microsoft Internet Explorer 5.5 or later
Windows Server 2003 Netscape Navigator 6.2 or later
Mac OS8.1~9.2.2 Netscape Navigator 6.2 or later
Mac OS X 10.1 or later Netscape Navigator 6.2 or later

? Limitation

3 If the Web browser in use is older than the recommended version or [Java-
Script] and [Cookie] are not effective, display and operation problems may
occur.

O If you use a proxy server, change the Web browser settings. Consult your
network administrator about the settings.

O Sometimes after clicking [Back] , the previous page may not appear. In this
case, click [Refresh] or [Reload] .

O This machine information cannot reload automatically. Click [Reload] or
[Refresh] on the Web browser when you want to reload this machine infor-
mation.

% Specifying the Address
Point the browser to the URL or IP address of the printer (e.g., ht-
tp:/ / XXX XXX XXX XXX/, where the Xs are the numbers in the IP address).
If the host name of the machine is registered on the DNS server or WINS serv-
er, you can enter it.

49



50

Appendix

Going to the Top Page

3 Web Image Monitor - Microsoft Intemnet Explorer

Fle Edi View Favoites Tods Help E
s ) Q B 3
Back  Fowzd | Stop  Reftssh  Home | Search Favortes Histoy | Mal  Pint | 4
Airess [{] hiip.//133.138.146.10/web/user/en/websys/webérch/mainFrame cgi = ﬁcl: U Links >
1
1 [Enaiish =] [ Top Page [ hdministrator Mode [ Help [ URL
>
2 Status lIRefmsh
2 Job WED Y S VOO
3 Contiguetion ® Device Name : RNPTADFEC
® Conuent
® Status
2 Prnter: () Ready
® Detail
Paint 10 each function with mouse pointer ta
display details
1
|#] Done

1. Header Area

You can register favorite URLs with
[URL]. To view the Help section, click
[HELP].

2. Menu Area
These Buttons are to configure the net-
work interface board and for checking
machine status.

3. Status

Displays the name and comments of the
network interface board, and machine
status.

4. Help
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Types of Menu Configuration and Mode

The items that appear on the menu area differ between user mode and adminis-
trator mode.

The work area which appears under the selected menu displays the status of the
machine under the user mode and the machine setting under the administrator
mode.

Menu User Mode AS)T;GLS;?
Status Input Tray O @]
Output Tray O O
Toner O @]
Function O O
System O o
Printer Language O o
Job Printer Job History O [ )
Error Log O o
Locked & Sample Print o o
Configuration | Paper — o
System — [
Printer O [
Notification — (]
E-mail O o
Network Interface O o
Protocol Protocol O [
TCP/IP O ®
NetWare O o
AppleTalk O [
SMB O o
SNMP — ®
System Log O O
Webpage O o
Security Password — [
Access Control — [
IPP Authentication — o

? Limitation

O Documents stored under the copier and printer functions cannot be down-
loaded. o1
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& Note
O Oin the list indicates that machine status can be displayed.

7 @ in the list indicates that machine settings can be changed.

A Reference
For more information about displaying status and changing settings, see p.53
“Using Help on the Web Browser”.

Verifying the Network Interface Board Settings

ﬂ Start the Web browser.

g Point your browser at the machine's URL or IP address (for example,
http:// XXX XXX.XXX.XXX, where the Xs are the number of the IP address).
The status of the machine you chose appears on the Web browser.

B Click the selected menu in the menu area.
If a sub-menu appears, click it.

A Reference
For more information about each item, see p.53 “Using Help on the Web
Browser”.

Configuring the Network Interface Board Settings

ﬂ Start the Web browser.

ﬂ Point your browser at the machine's URL or IP address (for example,
http:// XXX XXX XXX.XXX, where the Xs are the number of the IP address).

The status of the machine you chose appears on the Web browser.

B Click [Administrator Mode].
The dialog box for entering the password and user name is displayed.

ﬂ Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and enter “password”
for the password.

ﬂ Click the selected item in the menu area and make the necessary settings.

(3 click [appiy1.
The configuration is transmitted.
p Reference

For more information about making settings, see p.53 “Using Help on the
Web Browser”.
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Using Help on the Web Browser

When using Help for the first time, clicking either [Help] in the header area or the
icon marked "?" in the work area makes the following screen appear. From there
you can check Help in two different ways, as shown below:

% Checking a Help Using the Internet
You can check the latest Help updates.

< Downloading and Checking Help
You can download Help from the Internet.

& Note
O By clicking [Help] in the header area, Help contents normally appears.

O By clicking "?", the Help icon in the work area, Help for the items shown in
the work area normally appears.

Downloading Help

ﬂ Select the operating system in the [0S:] list.

ﬂ Select the language in the [Language] list.

E] Click [pownload).

ﬂ Download Help by following the messages on screen.

B Save the downloaded compressed file and decompress it.

@ Note

O To check the downloaded Help, specify the path where the document is
decompressed.

’l‘Q'f'-Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the com-
puter or Web server.

® Download the Help files on the machine to the desired location.

® Using a Web browser, navigate to Top Page and click [Administrator Mode].

® Click [Configration], and then click [Webpage].

@ Enter your password, (it is not necessary to enter a user name) and click [OK].

® Enter the path to the Help files in the [Help URL] box.
If you copied the Help files to “C:\HELP\EN", enter “file ://C:/HELP/”.
For example, if you copied the files to a Web server and the index URL is “ht-
tp:// a.b.c.d/HELP/EN/index.html”, enter “http://a.b.c.d/HELP/”.

® Click [Apply].
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Monitoring and Configuring the Printer

Changing Names and Comments

You can change printer names and make a comment on printers to easily iden-
tify the printers listed on SmartDeviceMonitor for Client.

The following utilities are used to change printer names and comments.

% SmartDeviceMonitor for Admin
Allows you to change names and comments when the TCP/IP protocol or
IPX/SPX protocol is available. You can install SmartDeviceMonitor for Ad-
min from the CD-ROM that comes with the printer. For more information
about installing SmartDeviceMonitor for Admin, see the Setup Guide.

< Web Browser
Allows you to change names and comments when the TCP/IP protocol is
available.

& Note

O Each of the names, in a TCP/IP protocol form (printer name) and in a Net-
BEUI protocol form, is changed individually. Comments are, however,
common to both of them.

O The factory default name consists of "RNP" and the last 3 bytes of the MAC
address on the Network Interface Board. For example, when the MAC ad-
dress is 00:00:74:62:7D:D5, the factory default name is "RNP627DD5".
Comments are not configured.

SmartDeviceMonitor for Admin

ﬂ Run SmartDeviceMonitor for Admin.

ﬂ Click the [Group] menu, point to [Search Device], and select [IPv4] or [IPX/SPX].
A list of printers appears.

@ Note
O Select the protocol of the printer you want to change its configuration.

B On the list, Select a printer whose Network Interface Board you want to
change its configuration.

ﬂ From the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.

B select [Property Sheet], and then click [OK].
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TCP/IP

@ Click the [General] tab, and then type the device name into the [Device
Name] box and comment into the [Comment] box.

¢ In the [Device Name] box, type the name of the printer in under 13 char-
acters. The factory default name consists of "RNP" and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

¢ In the [Comment] box, type any comment on printers in under 31 characters.

NetBEUI (Only Windows 2000)

@ Click the [General] tab, and then type the comment into the [Comment]
box.

In the [Comment] box, type any comment on printers in under 31 characters.
@ Click the [NetBEUI] tab.
© Type the computer name into the [Computer Name] box.

* In the [Computer Name] box, type the name that helps you to identify
printers using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numeric, or symbols (except
"*+,/5;<=>?[\]l. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid the duplication of the same name on a
network.

¢ In the [Comment] box, type any comment on printers in under 31 characters.

A click [ok.
The NIB Setup Tool exits, and the setting is transmitted to the printer.

ﬂ Exit SmartDeviceMonitor for Admin.

Web Browser

ﬂ Run the Web browser.

g Type the address "http:// (IP address of the printer you want to change the
settings)".

The status of the selected printer is displayed on the Web browser.

)
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B Click [Configuration].
A dialog box that prompts you to type the user name and a password
appears.

ﬂ Type the user name and the password, and then click [OK].

Type only the password in this dialog box. The factory default password is
"password".

B Change names and comments.

TCP/IP

@ Click [General], and then type the name into the [Device Name:] box and
comment into the [Comment] box.

* In the [Device Name:] box, enter the name of the printer in under 13 char-
acters. The factory default name consists of "RNP" and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to in under 13 characters.

* In the [Comment] box, type any comment on printers in under 31 characters.

NetBEUI (Only Windows 2000)

@ Click [NetBEUI].

@ Type the name into the [Computer Name] box and comment into the [Com-
ment] box.

* In the [Computer Name] box, type the name that helps you to identify
printers using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numeric, or symbols (except
"*+,/:;<=>?[\]I. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid the duplication of the same name on a
network.

¢ In the [Comment] box, type any comment on printers in under 31 characters.
(3 click [appiy1.
The setting is transmitted to the printer.

ﬂ Exit the Web browser.
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Displaying the Status of Printer

You can view the status of printers using SmartDeviceMonitor for Admin,
SmartDeviceMonitor for Client, or Web browser.

SmartDeviceMonitor for Admin

ﬂ Run SmartDeviceMonitor for Admin.

ﬂ Click the [Group] menu, point to [Search Device], and then select [IPv4] or
[IPX/SPX].

The status of printers is indicated with an icon in the list.

@ Note

O For more information about the status icons, see SmartDeviceMonitor for
Admin Help.

B Getting further information, click the desired printer to select from the list,
and then click [Open] on the [Device] menu.

The status of the printer is displayed on the dialog box.

& Note
O For more information about each item on the dialog box, see Help.

SmartDeviceMonitor for Client

Viewing the status of printers using SmartDeviceMonitor for Client, you must,
in advance, configure SmartDeviceMonitor for Client so it monitors the printer
whose status you want to view.

Monitoring Printers

ﬂ Run SmartDeviceMonitor for Client.
The SmartDeviceMonitor for Client icon appears at the right end of the
taskbar.

ﬂ Right-click the SmartDeviceMonitor for Client icon, and check if the de-
sired printer is configured on the pop-up menu that appears.
If it is configured, see SmartDeviceMonitor for Client Help.

B If the desired printer is not configured, click [Options] on the pop-up menu.
The [SmartDeviceMonitor for Client - Options] dialog box appears.

S/
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ﬂ Click the printer to be monitored, and select the [To Be Monitored] check box
from the [Monitoring Information Settings] group.

& Note
O Selecting the [Displayed on Task Bar] check box will bring up the status of a

printer with an icon on the SmartDeviceMonitor for Client icon on the task
tray.
B ciick [ok).

The dialog box closes and the configured printer is monitored.

Displaying the Status of Printers

ﬂ Run SmartDeviceMonitor for Client.

g The status of printers is displayed on the SmartDeviceMonitor for Client
icon on the task tray.

4 Note

O For more information about the status icons, see SmartDeviceMonitor for
Client Help.

B Getting further information on the status, right-click the SmartDeviceMon-
itor for Client icon, and then click the desired printer.
The status of the printer is displayed on the dialog box.

& Note
O For more information about each item on the dialog box, see Help.

Web Browser

ﬂ Run the Web browser.

ﬂ Type the address "http:// (IP address of the printer whose status you want
to view)".

The status of the selected printer is displayed on the Web browser.
8 Click [Status] and you can check the status of the printer.

& Note
O For more information about each item, see Help.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board us-
ing telnet.

@ Note

O You should specify a password so that only the network administrator, or a
person having network administrator privileges, can use remote maintenance.

Using telnet

The following is a sample procedure using telnet.

® Limitation
O Only one person at a time can be logged on to do remote maintenance.

ﬂ Using the IP address or host name of the machine, start telnet.
% telnet IP_ address

@ Note

O In order to use the host name instead of the IP address, you must write it
to the hosts file.

g Type the password.

& Note
O The default is “password”.

B Type a command.

/O Reference
For more information about telnet commands, see p.60 “Commands List”.

ﬂ Exit telnet.
msh> logout

When the configuration is changed, a message requests whether or not the
changes should be saved.

B Type “yes” to save the changes, and then press the [ENTER] key.

If you do not want to save the changes, type “no”, and then press the [ENTER]
key. If you want to make additional changes, type “return” at the command
line, and then press the [ENTER] key.

& Note
O If the “Cannot write NVRAM information” message appears, the changes
are not saved. Repeat the steps above.

O The Network Interface Board is reset automatically when the settings are
changed.

O When the Network Interface Board is reset, the active print job which has
already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.
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Commands List

Use this command to display remote maintenance use.

& Note
O Type “help” to see a list of commands that can be used.

msh> help

O Type “help command_name” to display information about the syntax of that
command.

msh> help command name

TCP/IP address

Use the ifconfig command to configure TCP /IP (IP address, subnet mask, broad-
cast address, default gateway address) for the machine.

< Reference
msh> ifconfig

% Configuration
msh> ifconfig interface name parameter address

Interface name Interface to be configured

ether Ethernet Interface ™!
nc0

"I If you did not enter the interface name, it will be automatically set to the Ethernet

interface.
Parameter Meaning
(no parameter) IP address
netmask subnet mask
broadcast broadcast address

The following is an example for configuring an IP address of 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0 on
Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

& Note

O This affects the configuration of the Network Interface Board of the IP ad-
dress that is used.

O To type an address using hexadecimal, prefix it by “0x”.
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1 Address

< Subnet Mask

A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

@ Note

0

To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control. You can also
specify two or more access ranges.

+ Reference

R
L4

msh> access

Configuration
msh> access % range start-address end-address

* 3 represents a target number between 1 and 5. (Up to five access ranges
can be registered and selected.)

Example: To specify accessible IP addresses between 192.168.0.10 and

192.168.0.20:

msh> access 1 range 192.168.0.10 192.168.0.20

4 Note

O The access range restricts the workstations from which printing is possible
by means of an address. If you do not need to restrict printing, make the
setting “0.0.0.0”.

O The entry is invalid if the start address is greater than the end address.

O Up to five access ranges can be specified. The entry is invalid if the target
number is omitted.

O When using a Web browser, telnet or SmartDeviceMonitor for Client/Ad-
min, you can use an IP address that has not been restricted by access control.

Access Control Initialization
msh> access flush

4 Note

O This restores the factory-default settings so that all access ranges become
"0.0.0.0".

o1
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Protocol

Use the set command to allow/prevent remote access for each protocol.
msh> set protocol {up | down}

Protocol

appletalk “up” means active and “down” means inac-
tepip tive.

netware
netbeui
smb

lpr

ftp

rsh
diprint
web

snmp

ipp

@ Note

O If you prohibit remote access using TCP/IP and then log out, you cannot use

remote access. If this was a mistake, you can use the control panel to allow ac-
cess by TCP/IP.

O When you prevent access via TCP/IP, you are also prevented from using ,lpr,
ftp, rsh, diprint, web, snmp and ipp.

DHCP

Use the "dhcp" command to configure the DHCP settings.

% Reference
The following command displays the current DHCP settings.
msh> dhcp

« Configuration
You can configure the DHCP settings.

msh> dhcp interface name {on|off}

& Note
3 Select [on] to enable DHCP. Select [off] to disable DHCP.

+ Interface Priority Configuration

You can assign priorities governing which interface obtains DHCP parame-
ters.

msh> dhcp priority interface name
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@ Note

O Priority assignment is useful when connecting more than one interface to the
machine.

O If an interface is not selected, it appears according to the currently set priority
regardless of multiple interface connections.

Interface name Interface to be configured

ether Ethernet interface

/O Reference
For more information about DHCP, see p.91 “Using DHCP”.

Printer status

The following commands can be used to get information about the current status
of the printer.

msh> command

Command Information that is displayed

status Status of printer.

Information about the print jobs.

info Information about the paper tray, output tray,
printer language of printer.
prnlog [ID] Lists the last 16 print jobs.
& Note

O More information about any print job is displayed when the ID number is
added after the prnlog command.

/O Reference

For more information about the meaning of the data returned with these com-
mands, see p.80 “Configuring the Network Interface Board”.

Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.

msh> show [-pl]

@ Note

O Add “-p” to the show command to have the information displayed one screen
at a time.

/O Reference

For more information about the meaning of the data returned with this com-
mand, see p.80 “Configuring the Network Interface Board”.
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System log information

Use the syslog command to display information stored in the machine's system
log.
msh> syslog

p Reference

For more information about the displayed information, see p.83 “System Log
Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

& Note
O You can configure from ten SNMP access settings numbered 1-10.

O Default access settings 1 and 2 are as follows.

Number 1 2
Community name public admin
IP address 0.0.0.0 0.0.0.0
Access type read-only read-write
trap off trap off
% Display

Shows the SNMP information and available protocols.
msh> snmp ?
msh> snmp [-p] [registered number]

& Note
O If the -p option is added, you can view the settings one by one.

O Omitting the number displays all access settings.

< Community name configuration
You can set the community name of the registered number.

msh> snmp number name community name

& Note
O The community name must consist of 15 characters or less.
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Access type configuration
You can select the access type from those listed below.
msh> snmp number type access type

Access type Type of access which is permitted
read Read only
write Read and write
trap User is notified of trap messages.
no All access is denied.

Protocol configuration
You should use the following command to set the protocols to active or inac-

tive. If you set a protocol to inactive, all access settings set to use that protocol
will be disabled:

msh> snmp {ip | ipx} {on | off}

* “on” means active and “off” means inactive.

To change the protocol of an access setting use the following command. How-
ever, if you disabled a protocol with the above command, making it active
here will have no effect.

msh> snmp number active {ip | ipx} {on | off}

Access configuration

You can configure the address of a host depending on protocols used.

The network interface board accepts requests only from hosts with addresses
“read-only” or “read-write” access type. Enter “0” to have the network inter-
face board accept requests from any host without requiring a specific type of
access.

msh> snmp number {ip | ipx} address

@ Note

O To specify TCP/IP protocol, enter ip followed by a space, and then the IP
address.

O To specify the IPX/SPX protocol, enter ipx followed by a space, and then
the IPX address followed by a decimal, and then the MAC address of the
network interface board.

The following is an example of how to configure registration number 3 with

the IP address 192.168.15.16:

msh> snmp 3 ip 192.168.15.16

The following is an example of how to configure registration number 3 with

the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65:

msh> snmp 3 ipx 7390A448:000074625C65
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IPP

Use the ipp command to configure the IPP settings.
% Viewing setting
The following command displays the current IPP settings.

msh> ipp
Example output:

timeout=900 (sec)
auth basic

¢ The “timeout” setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection can
be made.

¢ The “auth” setting indicates the user authorization mode.

« IPP timeout configuration
Specify how many seconds to wait before canceling a print job if it has been

interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.

msh> ipp timeout {30 - 65535}

% IPP user authorization configuration

Use the IPP user authorization to restrict users that can print with IPP. The de-
fault is “oft” .

ipp auth {basic|digest|off}
e “basic” and “digest” are user authorization setting.
e “off” removes the user's authorization.

& Note

O If you select “basic” or “digest”, see next section “Entry the IPP User Au-
thorization” for how to configure the user name. Up to ten user names are
available.

« Configuring the IPP user authorization
Use the following command:

ipp user

The following message appears.

Input user number (1 to 10):

Type the number, user name and password.

IPP user name:userl
IPP password:****xx%%
After configuring the settings, the following message appears.

User configuration changed.



Remote Maintenance by telnet

Direct Printing Port

The direct printing port allows printing directly from a computer, connected to
the network, to the printer.

Use the diprint command to change the direct printing port settings.
% View settings
The following command displays the current direct printing port settings.

msh> diprint
Example output:

port 9100
timeout=300(sec)
bidirect off

¢ The “Port” specifies the port number of the direct printing port.

¢ The “bidirect” setting indicates whether the direct printing port is bidirec-
tional.

+ Setting timeout
You can specify the timeout interval to use when receiving data from the net-
work.

msh> diprint [0~65535]

& Note
O The factory default is 300 seconds.

O If 0 is set, timeout is disabled.
+ Bidirectional configuration for the direct printing port

Use this setting to configure whether the direct printing port is bidirectional.
The factory default is “oft”.

msh> diprint bidirect {on|off}

& Note
O If you select “on”, SmartDeviceMonitor for Client or Standard TCP/IP on
Windows 2000 might not work correctly.
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SMB

Use the “smb” command to configure or delete the computer name, workgroup
name, or comment.

msh> smb parameter

Parameter Settings
comp Your computer name consisting of up to 15 characters
group Workgroup name consisting of up to 15 characters
comment Comment consisting of up to 31 characters
clear comp Clears the computer name
clear group Clears the Workgroup name
clear comment Clears comment

% Protocol Configuration
Use the following command to (in) activate the protocols.

msh> smb protcol protcol_name {up|down}

Protcol name

netbeui “up” means active and “down” means inactive

tepip

web

Use the “web” command to display and configure the parameters on the Web
browser.

% View Settings

msh> web

% URL Configuration
The link address reached by pressing [URL] on the Web browser can be set.

web url The URL or IP address you want to register.
Example:
(Xs represent the IP address.)

msh> web url http://XXX.XXX.XXX.XXX/

% Link Name Configuration
You can enter the name for [URL] that appears on the Web browser.

msh> web name Name you want to display
Example:
(Xs represent the name you want to display.)

msh> web name XXX
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% Help URL Configuration
The link address reached by pressing [Help] or “?” on the Web browser can be
set.
msh>web help Help URL or IP address
Example:
(Xs represent the IP address.)

msh> web url http://XXX.XXX.XXX.XXX/help/

ROUTE

Use the route command to control the routing table.

This command allows you to configure and display routing information. You
can change the network configuration from remote PCs using this command.

& Note
O The maximum number of routing tables are 16.
Commands Topics of setting

route add {host | net} desti- | Adds a host/network route to “destination”, and a gateway ad-
nation 1 gateway 1 dress to “gateway” in the table. Host becomes the default setting.
route delete {host | net} Deletes a host/network route from the table. Host becomes the
destination ™! default setting.
route get {destination " } Displays only route information corresponding to a specified

destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des- | You can turn the specified destination on or off. Host becomes
tination ! on/off the default setting.

route add default gateway " | You can set the default gateway address.

route flush Deletes all routing information.

1 TP address

SLP

Use this command to configure SLP settings.

You can search the NetWare server using SLP in the PurelP environment of
NetWare5/5.1. To use the slp command, you can configure the value of TTL
which can be used by the SLP multi-cast-packet.

@ Note

O The default value of TTL is “1”. A search is executed only within a local seg-
ment. If the router does not support multi-cast, the settings are not available
even if the TTL value is increased.

O The acceptable TTL value is 1 - 255.
msh> slp ttl {1 - 255}
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Job Spool

Use this command to configure Job Spool settings.

? Limitation

O You can only specify the LPR and IPP protocol.

< Reference
The job spool setting appears.

msh> spoolsw

% Job Spool Setting

msh> spoolsw spool {on | off}

& Note
O Specify "on" to enable the job spool function or "off" to disable it.

< Protocol Configuration

To change the protocol settings, use the following command. You can specify
the setting for [lpr] or [ipp].

o lpr

msh> spoolsw lpr {on | off}
* ipp

msh> spoolsw ipp {on | off}
e smb

msh> spoolsw smb {on |off}

Changing the Host Name

Use the hostname command to change the printer name.

msh> hostname [interface name ] printer name

interface name Interface to be configured

ether Ethernet interface ™

"I If you did not enter the interface name, it will be automatically set to the Ethernet in-
terface.

& Note
O Enter the printer name using up to 13 characters.

O You cannot use a printer name starting with RNP or rnp.
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WINS

Use the wins command to configure the WINS server settings

For more information about WINS server settings, see p.93 “Configuring a
WINS Server”.

% Viewing setting
The following command displays the WINS server IP address.

msh> wins
Example out put:

wins: primary server 0.0.0.0 secondary server 0.0.0.0
DHCP current config:

primary server 192.168.10.1 secondary server
192.168.10.2

hostname RNP620B47 ScopeID

4 Note

O If DHCP is used to start from the network, the current WINS server ad-
dress is displayed. This address, however, is not displayed if DHCP is not
used.

O If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.

% Configuration
Use the set command to make WINS active or inactive.

msh> set wins {on|off}
¢ "on'" means active and "off" means inactive.

% Address configuration
Use this command to configure a WINS server IP address.

msh> wins {primary|secondary} IP_address

& Note
O Use the "primary" to configure a primary WINS server IP address.

O Use the "secondary" to configure a secondary WINS server IP address.
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AutoNet

Use the "autonet” command to configure AutoNet settings.
% Display
The following command displays the current AutoNet settings.

msh> autonet

% Configuration
You can configure the AutoNet settings.

msh> autonet interface name {on|off}

& Note
O Select [on] to enable AutoNet.

3 Select [off] to disable AutoNet.

% Interface Priority Configuration
You can assign priorities governing which interface obtains AutoNet param-
eters.

msh> autonet priority interface name

4 Note

O Priority assignment is useful when connecting more than one interface to
the machine.

O If an interface is not selected, the interface appears according to the cur-
rently set priority, regardless of multiple interface connections.

Interface name Interface to be configured

ether Ethernet interface

A Reference
For more information about AutoNet, see p.92 “Using AutoNet”.
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SNTP

The printer clock can be synchronized with a NTP server clock using the Simple
Network Time Protocol (SNTP). To change the SNTP settings, use the sntp com-
mand. Confirm with the network administrator that the NTP server settings are
correct.

® Limitation

O SNTP supports the NTP servers running xnptd V3 and V4.

«» Reference
msh> sntp

« NTP Server Address Configuration
You can specify the IP address of the NTP server.
msh> sntp server IP address

+ Interval Configuration
You can specify the interval at which the printer synchronizes with the oper-
ator-specified NTP server.
msh> sntp interval polling time

@ Note
O The factory default setting is 3600 seconds.

O You can set the interval from 16 to 16384 seconds.

O If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the
NTP server.

+ Time-zone Configuration
You can specify the time difference between the printer clock and the NTP
server clock.

msh> sntp timezone +/-hour time
Example: To set the time-zone difference to +8 hours:

msh> sntp timezone +08:00

& Note
O The time is in 24-hour notation.
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Changing the password

Use the passwd command to change the remote maintenance password.

ﬂlmportant
O Be sure not to forget or lose the password.

& Note
O The default password is “password”.

ﬂ Type “passwd”.
msh> passwd

ﬂ Type the current password.
01ld password:

B Type the new password.

New password:

& Note

O The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

O The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

ﬂ Type the new password once again.

Retype new password:
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DNS

Use the "dns" command to configure or display DNS (Domain Name System)
settings.

2
*»*

2
*»*

View setting
The following command displays current DNS settings:

msh> dns

Using the DNS server obtained from the DHCP server

The following command enables/disables use the DNS server obtained from
the DHCP server:

msh> dns dhcp {valid | invalid}

¢ If you use the DNS server obtained from the DHCP server, select “valid”.
If not, select “invalid”.
If you set “valid”, the DNS server from the DHCP server is prioritized.

DNS server configuration
The following command enables/disables use of the DNS server address:

msh> dns number server / server address
The following is a sample configuration using an IP address of 192.168.15.16
on DNS 1 server:

msh> dns 1 server 192.168.15.16
* You can register up to three DNS server numbers.
* You cannot use “255.255.255.255” as the DNS server address.
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Domain name

Use the "domainname" command to display or configure domain name settings.
You can configure the Ethernet interface.
% View setting

The following command displays the current domain name:

msh> domainname

% Interface domain configuration
The following command displays or sets the Ethernet interface domain name.

msh> domainname / interface name
The following is a sample configuration using a domain name on the Ethernet
interface:

msh> domainname ether

Interface Interface that can be set

ether Ethernet interface

& Note
O A domain name can consist of up to 63 alphanumeric characters.

L Sefting Protocols

The protocols described in this section provide various functions that can be
used on the machine.

iﬁklmportant
O If a protocol is disabled or inactive, functions provided by that protocol can-

not be used.

/O Reference

For more information about setting protocols, consult your network adminis-
trator.

“ LPR
¢ Printer function using Standard TCP/IP
* Printer function using command line
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% RSH/RCP

* Printer function using command line
* Scanner function using the network TWAIN driver
* Function to obtain device information by command line

+ DIPRINT

* Printer function using SmartDeviceMonitor for Client

 FTP
* Printer function using command line
¢ Scanner function using a delivery server
¢ Function to obtain device information by command line

< IPP
¢ Printer function using SmartDeviceMonitor for Client

<+ NetWare

* Printer function using NetWare server (remote printer/printer server)

& Note
O If protocols are disabled or inactive under PurelP environment, only the

print server can be used.
% AppleTalk
* Printer function using Appletalk with Macintosh

& Note

O This function can be selected when a module supporting PostScript 3 is at-
tached.

“ SMB
* Printer function using SmartDeviceMonitor for Client
* Printer function using Microsoft Windows Network

< SNMP
* Bidirectional configuration for the printer driver

¢ Function to obtain device information by SmartDeviceMonitor for Ad-
min/Client
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SNMP

The Network Interface Board functions as an SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.

The default community names are “public” and “admin”. You can get MIB in-
formation using these community names.

/O Reference

You can configure SNMP from the command line using telnet. See p.64
“SNMP”.

You can configure SNMP from SmartDeviceMonitor for Admin using the
NIB Setup Tool. See Help for SmartDeviceMonitor for Admin.

You can configure SNMP from your Web browser. See Help on the CD-ROM.

? Limitation

O The kinds of supported MIBs vary depending on the printer.

« Supported MIBs
e MIB-II
¢ PrinterMIB
¢ HostResourceMIB
¢ RicohPrivateMIB
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Understanding the Displayed Information

This section describes how to read the status information returned by the Net-
work Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.
¢ telnet : Use the status command. See p.63 “Printer status” .

Item name Meaning
Rank Print job status.
e Active
Printing or preparing for printing.
* Waiting
Waiting to be transferred to the printer.
Owner Print request user name.
Job Print request number.
Files The name of the document.
Total Size The size of the data (spooled).

The default is “0 bytes”.

Print Log Information

This is a record of the most recent 16 jobs that have been printed.
This log can be displayed with the following commands.
¢ telnet : Use the prnlog command. See p.63 “Printer status” .

Name Meaning
ID Print request ID.
User Print request user name.
Page The number of pages that is printed.
Result The result of the print request.
Time The time when the print request was received
UserID ™! User ID that is to be configured in the printer driver.
JobName The name of the document for printing.

"I Appears the UserID and JobName information when entering the info command

with the ID.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed by using the commands

below.

¢ telnet : Use the show command. See p.63 “Network Interface Board configu-

ration settings information” .

Item name

Meaning

Common

Mode

Protocol Up/Down
AppleTalk
TCP/IP
NetWare
NetBEUI

smb

Ethernet interface

Up means active, Down means inactive.

Syslog priority
NVRAM version Internal version number.
Device name
Comment
Location
Contact
Soft switch
AppleTalk
Mode AppleTalk protocol in selection.
Net Network number.
Object Macintosh printer name.
Type The type of printer.
Zone Name of the zone that the printer belongs to.
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Item name

Meaning

TCP/IP
Mode
ftp
lpr
rsh
diprint
web
http
ftpc
telnet
snmp
ipp
autonet
EncapType
Address
Netmask
Broadcast
Gateway
Access Range[+] ™

Time server

Up means active, Down means inactive.

Frame type.

IP address.

Subnet mask.

Broadcast address.

Default gateway address.
Access Control Range.
NTP server address

NTP server time difference

Synchronizes interval

Time Zone URL of homepage.
Time server polling time URL name of homepage.
Syslog server URL of help page.
Home page URL Protocol used with SNMP.
Home page link name
Help page URL
SNMP protocol
NetWare
EncapType Frame type.
RPRINTER number Remote printer number.

Print server name
File server name
Context name
Switch
Mode
NDS/Bindery
Packet negotiation
Login Mode

Print job timeout

Print server name.
Name of the connect file server.

Context of print server.

Active mode.

(this value is fixed)

Select File Server Mode or NDS Mode as the Logon
Mode.

Time of the job timeout.
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Item name

Meaning

Protocol

SAP internal time

For the protocol used for communication with the print
server, select from TCP /IP+IPX, IPX, and TCP/IP.

Workgroup name

Computer name

Comment

Share name[1]
Protocol

NetBEUI TCP/IP

NDS Tree Name The SAP sending interval for service notification from
the device side.
The name of the connected NDS Tree.
SMB
Switch
Mode (this value is fixed)
Direct Print (this value is fixed)
Notification Notification of print job completion.

Name of the workgroup.
Name of the computer.
Comment.

Share name (name of the printer type).

Shell mode

Mode of the remote maintenance tool.

Domain name

ether Ethernet interface domain name
WINS
ether Ethernet interface WINS name
Primary WINS Primary WINS server address
Secondary WINS Secondary WINS server address
Shell mode Mode of the remote maintenance tool

"I 5% represents a target number between 1 and 5.
"2 3¢ represents a target number between 1 and 3.
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Message List

This is a list of messages written to the machine's system log. The system log can

be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.

¢ telnet : Use the syslog command. See p.64 “System log information” .

Message

Description and Solutions

Access to NetWare server <file servername>
denied. Either there is no account for this print
server on the NetWare server or the password
was incorrect.

(In print server mode) Cannot log in to the file
server. Make sure that the print server is regis-
tered on the file server. If a password is speci-
fied for the print server, delete it.

add_sess: community<community name> al-
ready defined.

The same community name already exists.
Use another community name.

add_sess: session<community name>already
defined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>,
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is
TRAP. Specify the host IPX address for the
TRAP destination.

add_sess_ipx: community <community
name> already defined.

The same community name already exists.
Use another community name.

add_sess_ipx: session_ipx<community name>
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM <IP ad-
dress>, <password>

An anonymous login has been made with a
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk)

An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer =<file server name>

Attached to the file server as a nearest server.

Attach to print queue <print queue name>

(In print server mode) Attached to the print
queue name.

Cannot create service connection

(In remote printer mode) Cannot establish a
connection with the file server. The number of
file server users may exceed the maximum
number that the file server can handle.
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Message

Description and Solutions

Cannot find rprinter (<print server
name>/ <printer number>)

The printer having the number displayed on
the print server does not exist. Make sure that
the number of the printer is registered in the
print server.

Change IP address from DHCP Server.

The IP address changes when DHCP LEASE is
renewed. To always assign the same IP address,
set a static IP address to the DHCP server.

child process exec error! (process name)

Failed to start the network service. Turn the
printer off and then on. If this does not work,
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from
the DHCP server.

connection from <IP address>

Logged on from the host <IP address>.

Could not attach to FileServer<error number>

(In remote printer mode) Cannot attach to the
file server. For some reason, the file server
refuses the connection. Check the file server
configuration.

Could not attach to PServer<print server>

(In remote printer mode) Cannot attach to the
print server. For some reason, the print server
refuses the connection. Check the print server
configuration.

Current Interface Speed:xxxMbps

The speed of the network (10 Mbps or 100 Mbps).

Current IP address <current IP address>

The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address<IPX address>

The current IPX address.

DHCP lease time expired. DHCP lease time has expired. The printer tries
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCEP server not found. The DHCP server cannot be found. Make sure
the DHCP server is running on the network.

dhcped start. A dhcped (DHCP client service) has started.

Duplicate IP=<IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address
must be unique. Check the address of the de-
vice indicated in <MAC address>.

Established SPX Connection with PServer,
(RPSocket=<socket number>, connID=

<connection ID>)

(In remote printer mode) A connection with
the print server has been established.

exiting

Ipd service has ended and the system is exiting
the process.

Exit pserver

(In print server mode) Exits the print server
because the necessary print server settings
have not been made.
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Message

Description and Solutions

failed to connect smtp server.

Failed to connect the SMTP server. This could
be because:

e There is no connection to the network.

¢ The network configuration is incorrect, so
there is no response from the SMTP server.

¢ The SMTP server name is incorrect.
* The specified SMTP server is incorrect.

¢ There is no specified SMTP server IP ad-
dress in the DNS server.

¢ Another server other than the SMTP server
has been specified.

¢ The SMTP server port number is incorrect.

failed to connect smtp server. timeout.

Failed to connect the SMTP server due to time-
out. This could be because:

e The SMTP server name is incorrect.
¢ There is no connection to the network.

¢ The network configuration is incorrect, so
there is no response from the SMTP server.

failed to get smtp server ip-address.

Failed to get the SMTP server IP address. This
could be because:

¢ The DNS server could not be found.
e There is no connection to the network.

¢ The specified DNS server could not be con-
nected to.

¢ Incorrect DNS server is specified.

* No specified SMTP server IP address in the
DNS server.

Frametype =<frame type name>

The <frame type name> is configured to be
used on NetWare.

httpd start.

An httpd has started.

inetd start.

An inetd has started.

<interface> started with IP: <IP address>

<IP address> has been set for <Interface> and
<Interface> started.

<Interface>: Subnet overlap.

Subnet from Netmask and the IP address you
tried to set for <Interface> overlap the subnet
for another interface.

Set Subnet so that it does not overlap with an-
other interface.

IPP cancel-job: permission denied.

The printer could not authenticate the name of
the user attempting to cancel a job.

ipp disable.

Printing with ipp is disabled.

ipp enable.

Printing with ipp is enabled.
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Message

Description and Solutions

IPP job canceled. jobid=&percnt;d.

The spooled job has been canceled due to an
error or by user request.

job canceled. jobid=&percnt;d.

The spooled job has been canceled due to an
error or by user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time that was received from
the DHCP server is <lease time> in seconds.
The renewal time is also <renew time> in sec-
onds.

Login to fileserver <file server name>
(<IPX | IP>,<NDS | BINDERY>)

(In print server mode) Logged in to the file
server with NDS or BINDERY mode.

multid start.

Data transmission service for multiprotocols
has started.

nbstart start. (NetBEUI)

The service for NetBEUI protocol stack setting
has started.

NBT Registration Broadcast(<NetBIOS
name>)

Use alocal broadcast to map <NetBIOS name>
with the IP address.

nbtd start.

A nbtd (NetBIOS over TCP/IP Daemon) has
started. (Available only in DHCP mode)

NetBEUI Computer Name =<computer
name>

The NetBEUI Computer Name is defined as
<computer name>.

nmsd start. (NetBEUI)

A nmsd (Name Server Daemon) has started.

no smtp server. connection close.

No response from the SMTP protocol. Cannot
connect to the SMTP server. This could be be-
cause:

¢ Another server other than the SMTP server
has been specified.

¢ The SMTP server port number is incorrect.

npriter start. (NetWare)

(In remote printer mode) NetWare service has
started.

nwstart start. (NetWare)

The service for NetWare protocol stack setting
has started.

Open log file <file name>

(In print server mode) The specified log file
has been opened.

papd start. (AppleTalk)

AppleTalk print service has started.

permission denied.

Job cancellation was determined to be unau-
thorized after checking the user name and host
address (except for ROOT authorization).

phy release file open failed.

Replacing the Network Interface Board is re-
quired. Contact your sales or service repre-
sentatives.

Print queue <print queue name> cannot be
serviced by printer 0, <print server name>

(In print server mode) The print queue name
cannot be serviced. Make sure that print queue
volume exists on the specified file server.
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Message

Description and Solutions

Print server <print server name> has no printer.

(In print server mode) The printer object is not
assigned to the print server <print server
name>. Using NWAdmin, assign the printer
object, and then restart the printer device.

Print session full

Cannot accept the print session.

Printer <printer name> has no queue

(In print server mode) The print queue is not
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then re-
start it.

pserver start. (NetWare)

(In print server mode) NetWare service has
started.

refused connect by smtp server.

The connection to the SMTP server is denied.
This could be because:

¢ Another server other than the SMTP server
has been specified.

¢ The SMTP server port number is incorrect.

Required computer name (<Computer
name>) is duplicated name

The same computer name is detected on the
network. The start job determines the compu-
ter name by adding the computer name to the
suffix (0,1....). Configure a new computer
name that is unique.

Required file server (<file server name>) not
found

Cannot find the required file server.

restarted.

LPD has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP (SAP
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name>

A <NDS context name> has been set.

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUI)

An smbd (SMB (Server Message Block) serv-
ice) has started.

Snmp over ip is ready.

Communication over TCP/IP with SNMP is
available.

Snmp over ipx is ready.

Communication over IPX with SNMP is avail-
able.

snmpd start.

SNMP service has started.

started.

Direct print service has started.

The print server received error <error
number> during attempt to log in to the net-
work.Access to the network was denied.Verify
that the print server name and password are
correct.

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without
specifying a password.
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Message

Description and Solutions

username or password wasn't correct.

Failure to establish a connection with the
SMTP server. The following causes can be at-
tributed.

¢ Incorrect SMTP user name assigned.

¢ Incorrect SMTP password assigned.

win2kspd protocol-DOWN (APPEXIT).

NVRAM setting ioctl (SPIO CAPPEXIT) of de-
vice SBP2TSP was set by protocol-DOWN.

SCSI print is not receiving data.

win2kspd protocol-UP (APPENTRY).

NVRAM setting ioctl (SPIO CAPPENTRY) of
device SBP2TSP was set by protocol-UP.

SCSI print is not receiving data.

win2kspd started.

SCSI print (SBP-2) service has started.

WINS name refresh :Server No Response

There has been no response to the update re-

quest from the server. Confirm that the WINS
server address is correct and the WINS server
is working properly.

WINS name registration/refresh error code
<error number>

Set unique (not shared) NetBIOS names.

Confirm the WINS server address is correct
and working properly.

WINS name registration:Server No Response

There has been no response to the registration
request from the server. Confirm that the
WINS server address is correct and the WINS
server is working properly.

WINS server address0.0.0.0

The WINS server address has not been speci-
fied. Specify the WINS server address to
match the printer name with WINS.

WINS Server=<WINS server address> NetBI-
OS Name=<NetBIOS name>

The printer name has been successfully regis-
tered in <WINS server address>.

WINS wrong scopelD

The scope ID is wrong.
Specify the correct scope ID.

write error occurred. (diskfull)

The hard disk became full while the spool file
was being written.

Wait until enough HDD space becomes avail-
able as printing proceeds.

write error occurred. (fatal)

A fatal error occurred while the spool file was
being written.

Turn the printer off and then on. If this does
not work, contact your service or sales repre-
sentative.




Precautions

Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial-up router.

& Note

O The MAC address of the printer doing the filtering is printed on the printer
configuration page. For more information about printing a configuration
page, see the Setup Guide.

O For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

ﬂ Following the setup method in this manual, configure the file server.
ﬂ Set the frame type for a NetWare environment.

A Reference
For more information about selecting a frame type, see the Setup Guide.

Configuring the printer without NetWare

ﬂ While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

A Reference
For more information about selecting a protocol, see the Setup Guide.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Operating Instruc-
tions Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not work properly. If you want to change the form feed setting, al-
ways configure it on Windows.

e With Windows 2000/ XP/Vista, Windows Server 2003, clear the [Form feed]
check box on the [NetWare Settings] tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows.

e With Windows 2000/ XP/Vista, WIndows Server 2003, clear the [Enable ban-
ner] check box on the [NetWare Settings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Due to the NetWare speci-
fication, print jobs may be accepted, but they will not be printed during this in-
terval.

When using the machine as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print.



Precautions

Using DHCP

You can use the printer under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

< When a static IP address is set for both interfaces

o [P Address: If interface IP addresses overlap, the Ethernet interface is se-
lected.

* Subnet Mask: If interface subnet masks overlap, the Ethernet interface is
selected.

* Gateway Address: The selected value is applied.

& Note
O Make the gateway address setting inside the subnet set in the interface.

O If a value is beyond the range of the subnet selected by the interface, the
machine operates with "0.0.0.0".

% When obtaining addresses from the DHCP server

e JP Address, Subnet Mask: You can configure addresses assigned by a
DHCP server.

& Note

O If IP addresses overlap or the same subnet IP addresses are selected, the
effective value is assigned only to the prioritized interface.

O Default interface priority is Ethernet.

¢ AutoNet: A temporary IP address starting with 169.254 that is not used on
the network, assigned to the prioritized interface.

¢ Gateway Address, DNS Server Address, and Domain Name: You can con-
figure the addresses assigned by DHCP to the prioritized interface.

& Note
O Default interface priority is Ethernet.

< When there are static IP addresses and addresses assigned by DHCP

¢ JP Address and subnet mask: If a static IP address is the same as an address
assigned by DHCP, or the static subnet mask address and the subnet mask
address assigned by DHCP overlap, the machine uses the static IP address
interface.

& Note
O The interface with the DHCP setting is set by default.

* Gateway Address: Operates with the address entered manually.

4 Note

O If a static address is not selected, or is set to 0.0.0.0, the interface with the
address assigned by DHCP is used.

91



92

Appendix

@ Note

O Printers that register the printer NetBIOS name on a WINS server must be
configured for the WINS server. See p.71 “WINS”.

O Supported DHCP servers are Windows 2000, Windows XP Professional, Win-
dows Vista, Windows Server 2003 Server, and NetWare 5/5.1, 6.

O If you do not use the WINS server, reserve the printer's IP address in the
DHCP server so that the same IP address is assigned every time.

O To use the WINS server, change the WINS server setting to “active” using the
control panel.

O Using the WINS server, you can configure the host name via the remote net-
work printer port.

O DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-
work via an ISDN line, it will result in expensive line charges. This is because
your computer connects to the ISDN line whenever a packet is transferred
from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254 which is not used on the network can be
selected automatically by the printer.

& Note
O The IP address assigned by the DHCP server is given priority to that selected
by AutoNet.

O You can confirm the current IP address on the configuration page. For more
information about the configuration page, see the Printer Reference.

O When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

O The machine cannot communicate with devices that do not have the AutoNet
function.



Precautions

Configuring a WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the printer to be
specified from SmartDeviceMonitor for Admin even under a DHCP environ-
ment.

This section describes how to configure the WINS server.

& Note
O The WINS Server is supported with Windows 2000 Servers WINS Manager.

O For more information about the WINS Server settings, see Windows Help.

O If there is no reply from the WINS Server, the NetBIOS name will be regis-
tered by broadcast.

O The NetBIOS name consists of up to 13 alphanumeric characters.

Using a Web browser

ﬂ Start the Web browser.

BPoint your browser at the URL or IP address of the printer (e.g. ht-
tp:/IXXX XXX XXX. XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

B Click [Administrator Mode].
The dialog box for entering the password and user name is displayed.

ﬂ Enter your user name and password, and then click OK.

To use the factory default account, enter no user name and type "password"
for the password.

B Point to [Configuration], [Network], [Protocol], and then click [TCP/IP].

B Set WINS to [Enable] and enter the IP address of the WINS server in [Primary
WINS Server;] and [Secondary WINS Server] boxes.

U click [Appiy].
8 Quit the Web browser.
g Exit the Web browser.
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Using telnet

ﬂ Connect to the remote printer using telnet.

ﬂ Use the "set" command to make WINS active.

msh> set wins on

B Specify the IP addresses (primary and secondary) using the following
commands.

msh> wins primary Ipaddress msh> wins secondary Ipaddress

& Note
O To confirm the current configuration, use the "show" command.

ﬂ Log out from telnet.



Precautions

When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, make
sure that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

* The network printer can only receive one print job from SmartDeviceMonitor
for Client at a time. While the network printer is printing a job, another user
cannot access the network printer until it completes the job. In this case,
SmartDeviceMonitor for Client tries to access the network printer until the re-
try interval expires.

¢ If SmartDeviceMonitor for Client cannot access the network printer and times
out, SmartDeviceMonitor for Client stops sending the print job. In this case,
you should cancel the paused status from the print queue window. SmartDe-
viceMonitor for Client will resume access to the network printer. You can de-
lete the print job from the print queue window, but canceling a print job that
has been printed by the network printer might cause the next print job sent
from another user to be incorrectly printed.

¢ If a print job that is sent from SmartDeviceMonitor for Client is interrupted
and the network printer cancels the job because something went wrong,
launch the print job again.

* Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

e If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be in the order in which the jobs
were sent.

* An IP address cannot be used for the IPP port name because the IP address is
used for the SmartDeviceMonitor for Client port name.
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Specifications

Interface 100BASE-TX, 10BASE-T

Frame type EthernetIl, SNAP

Protocol e TCP/IP
Windows 2000
Windows XP
Windows Vista
Windows Server 2003

e IPX/SPX

NetWare 3.12,3.2,4.1,4.11,4.2,5,5.1, 6, IntranetWare

e NetBEUI 1
Windows 2000

e IPP
Windows 2000
Windows XP
Windows Vista
Windows Server 2003

e SMB
Windows 2000
Windows XP
Windows Vista
Windows Server 2003
e AppleTalk
Mac OS 8.6 or later
Mac OS X 10.1 or later

SNMP MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB

I To use NetBEUI, use the SmartDeviceMonitor for Client port.
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